
SOURCETRONIC – Quality electronics for service, lab and production

ST®Drive

User Manual



ST®Drive  Table of Contents 

v1.1  1 

Table of Contents 

Table of Contents .......................................................................................................................................... 1 
1 Adding a Device ........................................................................................................................................... 3 

1.1 How to Use .......................................................................................................................................... 3 
1.2 Elements .............................................................................................................................................. 3 

2 Adding a Device Automatically .................................................................................................................... 4 
2.1 How to Use .......................................................................................................................................... 4 
2.2 Elements .............................................................................................................................................. 4 

3 Settings ....................................................................................................................................................... 5 
3.1 How to Use .......................................................................................................................................... 5 
3.2 Elements .............................................................................................................................................. 5 

4 Device Information ..................................................................................................................................... 6 
4.1 How to Use .......................................................................................................................................... 6 
4.2 Elements .............................................................................................................................................. 6 

5 Parameter Groups ...................................................................................................................................... 7 
5.1 How to Use .......................................................................................................................................... 7 
5.2 Elements .............................................................................................................................................. 7 

6 Changing a Parameter Value ..................................................................................................................... 8 
6.1 How to Use .......................................................................................................................................... 8 
6.2 Elements .............................................................................................................................................. 8 

7 Changing a Numerical Parameter Value ................................................................................................... 9 
7.1 How to Use .......................................................................................................................................... 9 
7.2 Elements .............................................................................................................................................. 9 

8 Overview .................................................................................................................................................... 10 
8.1 How to Use ........................................................................................................................................ 10 
8.2 Elements ............................................................................................................................................ 10 

9 Logging ..................................................................................................................................................... 11 
9.1 How to Use ........................................................................................................................................ 11 
9.2 Elements ............................................................................................................................................ 11 

10 PDF Export .............................................................................................................................................. 12 
10.1 How to Use ...................................................................................................................................... 12 



ST®Drive  Table of Contents 

v1.1  2 

10.2 Elements .......................................................................................................................................... 12 
11 Export Parameters in a Custom Format ................................................................................................ 13 

11.1 How to Use ...................................................................................................................................... 13 
11.2 Elements .......................................................................................................................................... 13 

12 Software Update ...................................................................................................................................... 14 
12.1 How to Use ...................................................................................................................................... 14 

13 About the Software ................................................................................................................................. 15 
13.1 How to Use ...................................................................................................................................... 15 

14 FAQ.......................................................................................................................................................... 16 
14.1 ST®Drive fails to establish a connection to the ST500 frequency inverter, what can I do? ................ 16 



ST®Drive  Adding a Device 

v1.1  3 

1 Adding a Device 
Description: This dialog window allows you to add a new device manually.  

 

1.1 How to Use 
Open the ST®Drive software on your computer. 

1) Click the green button in the bottom left-hand corner of the application to expand the drop-down menu. 

2) Click the "Add Device Manually" button. This opens a new dialog window. 

3) Enter the required information. 

4) Finally, click the "Add" button to add the device. 

1.2 Elements 
• Device: Select the VFD model that you have connected. If a different device is selected, the baud rate is 

automatically adjusted. 

• Device Address: Enter the device address. This must match the address parameterized in the VFD. 

• COM Port: Define the COM port to which the VFD is connected. The corresponding COM port can be 

found in the device manager. 

• Baud Rate: Enter the baud rate parameterized in the VFD.  

• Display As: Enter a name for the device so that it can be easily identified.
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2 Adding a Device Automatically 
Description: This dialog window allows you to automatically add a new device. 

  

2.1 How to Use 
1) Click the green button in the bottom left-hand corner of the application to expand the drop-down menu. 

2) Click the "Search for Device(s)" button. This opens a new dialog window. 

• The drop-down menu can be used to select whether to search for the ST500 or ST600 device series.  

• If "Automatic" is selected, both models will be searched for. 

3) Start the search by clicking the "Start" button. 

When a device is detected, it is automatically added. 

2.2 Elements 
• Device: Define whether to search for ST500, ST600, or both devices. 

• Start: Start the search. 
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3 Settings 
Description: This dialog window allows you to adjust settings. 

 

3.1 How to Use 
1) Go to the "File" tab.  

2) Click "Settings". A new dialog window opens. 

• In the "General" tab, you can change the language and activate logging. Personal information can 

also be entered here. 

• In the "Appearance" tab, you can configure whether or not the application should be minimized when 

it is closed. 

• The "Communication" tab offers various options regarding write settings, error handling and standards. 

3) Click the "Save Settings" button to apply the changes, or click the "Don't Save Settings" button to discard 

the changes. 

3.2 Elements 
• Language: Here you can switch between English and German. The software must be restarted for the 

language change to be applied. 

• Logging: If the checkbox is ticked, the logging function can be used. 

• Personal Information: Here you can enter your personal information, such as name, organization, email 

and post address. 

• Minimize When Closing: If this check mark is set, the application is only minimized when closing instead 

of being terminated entirely. 
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4 Device Information 
Description: This layout displays basic information about a selected device. 

 

4.1 How to Use 
Select a device from the list to display its basic information in the "Basic Device Information" layout. 

4.2 Elements 
• Device Series: The device series is displayed here, e.g. ST500 or ST600. 

• Model: The VFD model is displayed here. 

• Power Size: The power class of the VFD is displayed here. 

• Input Voltage: The input voltage of the VFD is displayed here. 

• Input Frequency: The frequency in the VFD input is displayed here. 

• Output Current: The currently measured output current of the VFD is displayed here. 

• Output Voltage: The currently measured output voltage is displayed here. 

• Output Frequency: The output frequency is displayed here. 

• Device Address: The device address is displayed here. 

• COM Port: The COM port to which the VFD is connected is displayed here. 

• Software Version: The current software version is displayed here. 

• Baud Rate: The set baud rate is displayed here.
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5 Parameter Groups 
Description: This layout shows all parameter groups and their descriptions.  

 

5.1 How to Use 
1) Navigate to the "All Parameter Groups" section. The tree structure shows all available parameter groups.  

2) Click on a parameter group to display its parameters. 

3) Click on a specific parameter to display further details and settings. 

5.2 Elements 
• Parameter Tree: All parameter groups and parameters are displayed here in a hierarchical structure. 

• Parameter Groups: Lists of parameters that are organized within different categories. 

• Group Name: Name of the parameter groups. 

• Description: Description of the parameters in the group.
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6 Changing a Parameter Value 
Description: This dialog window allows you to edit a parameter using a list of available functions. 

 

6.1 How to Use 
1) Click on a parameter you wish to change. The "Enter New Value" dialog window opens. 

2) Select the desired parameter value from the list. The function of the currently selected parameter value is 

defined in the "Description" field. 

3) Use the drop-down menu to select whether the parameter value is to be written to the EEPROM 

(nonvolatile) or to the RAM (volatile). 

4) Click the "Write to Device" button to write the parameter to the VFD, or click the "Don't Write Anything" 

button to close the window and not apply the changes. 

6.2 Elements 
• EEPROM (nonvolatile): The parameter value is written to the nonvolatile EEPROM. This means that the 

parameter remains permanently stored, even if the VFD is disconnected from the mains. 

• RAM (volatile): The parameter value is temporarily written to the volatile RAM. When the VFD is 

disconnected from the mains, the parameter is reset. 

• Description: The currently selected parameter value is described here. 

• Write to Device: The parameter value is written to the VFD. 

• Don't Write Anything: The parameter change is discarded and the dialog closes.
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7 Changing a Numerical Parameter Value 
Description: This dialog window allows you to enter a numerical value in a parameter. 

 

7.1 How to Use 
1) Click on a parameter you wish to change. The "Enter New Value" dialog window opens. 

2) Manually enter a value within the setting range or use the arrow buttons. The parameter's function is defined 

in the "Description" field. 

3) Use the drop-down menu to select whether the parameter value is to be written to the EEPROM 

(nonvolatile) or to the RAM (volatile). 

4) Click the "Write to Device" button to write the parameter to the VFD, or click the "Don't Write Anything" 

button to close the window and not apply the changes. 

7.2 Elements 
• EEPROM (nonvolatile): The parameter value is written to the nonvolatile EEPROM. This means that the 

parameter remains permanently saved, even if the VFD is disconnected from the mains. 

• RAM (volatile): The parameter value is temporarily written to the volatile RAM. If the VFD is disconnected 

from the mains, the parameter is reset. 

• Description: The currently selected parameter is described here. 

• Write to Device: The parameter value is written to the VFD. 

• Don't Write Anything: The parameter change is discarded and the dialog window closes.
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8 Overview 
Description: This layout provides an overview of digital inputs and outputs, as well as the monitoring parameters. 

 

8.1 How to Use 
Click the "Overview" item on the left-hand side of your screen. The inputs and outputs of the VFD can be observed 

in the overview, as well as various monitoring parameters.  The VFD can be controlled and the device status can 

be queried via the control center. 

8.2 Elements 
• Forward Start: Starts the VFD in forward-running mode with the frequency set by F0.03. 

• Reverse Start: Starts the VFD in reverse-running mode at the frequency set by F0.03. 

• Brake & Stop: Brakes the VFD with the braking time set in F0.14. 

• Forward JOG: Starts the VFD in forward-jogging mode with the frequency set in F7.00. 

• Reverse JOG: Starts the VFD in reverse-jogging mode at the frequency set in F7.00. 

• Free Stop: The output of the VFD is switched off, meaning it no longer controls the braking process. 

• Device Status: Indicates the status of the VFD. 

• Digital Inputs: Shows whether a digital input is active. Clicking on a digital input displays its function. 

• Analogous Inputs (V): Displays the voltage currently present at the corresponding analog input. 

• Digital/Pulse & Relay Outputs: Shows which digital output is currently active. Clicking on a digital output 

displays its function. 

• Additional Monitoring Parameters: Displays the monitoring parameter group of the VFD.
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9 Logging 
Description: This layout enables the logging of information, events and actions of the VFD. The results can be 

exported as a CSV file.  

 

9.1 How to Use 
The VFD can be controlled and the device status can be queried via the control center. Log entries are displayed 

in the logging window, including timestamp, event and various details. 

9.2 Elements 
• Forward Start: Starts the VFD in forward-running mode with the frequency set by F0.03. 

• Reverse Start: Starts the VFD in reverse-running mode at the frequency set by F0.03. 

• Brake & Stop: Brakes the VFD with the braking time set in F0.14. 

• Forward JOG: Starts the VFD in forward-jogging mode with the frequency set in F7.00. 

• Reverse JOG: Starts the VFD in reverse-jogging mode at the frequency set in F7.00. 

• Free Stop: The output of the VFD is switched off, meaning it no longer controls the braking process. 

• Device Status: Indicates the status of the VFD. 

• Logging Interval: The time interval between measurements is entered here. This is specified in 

milliseconds (ms). 

• Start/Stop Logging: Use this button to start and stop logging. 

• CSV Export: This button can be used to export the logging table as a CSV file once logging is complete. 

• Logging Table: List of log entries with timestamps and details.
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10 PDF Export 
Description: This dialog window allows you to export a parameter list as a PDF file. 

 

10.1 How to Use 
1) Go to the "File" tab. 

2) Click "Export as PDF". 

3) Select a device from the list or activate the "Select All" checkbox below the device list. 

• If you activate the "Only Show Differences" checkbox, only the changed parameters are exported 

as a PDF. 

4) Select the storage location and enter the file name. 

5) Click "Export" to create the PDF file or "Don't Export" to cancel the process. 

10.2 Elements 
• Device List: The devices added in the software can be selected here to export their parameters as a PDF. 

• Checkbox "Select All": If the box is checked, all devices in the list are selected. 

• Checkbox "Only Show Differences": The exported PDF only contains the changed parameters. 

• Select File: Here you can select the path and assign the file name. 

• Export: A PDF is exported in the previously defined path. 

• Don't Export: The export process is canceled and the window closes. 
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11 Export Parameters in a Custom Format 
Description: This dialog window allows you to export data in your own user-defined format. 

 

11.1 How to Use 
1) Click on the "File" menu item. 

2) Click on "Export as Own File". 

3) Select a device from the selection list or activate the "Select All" checkbox below the device list. 

4) Select the storage location and enter the file name. 

5) Click on "Save It" to create the file or on "Don't Save It" to cancel the process. 

11.2 Elements 
• Device List: The devices added in the software can be selected here to export their parameters as a PDF. 

• Checkbox "Select All": If the box is checked, all devices in the list are selected. 

• Select File: Here you can select the path and assign the file name. 

• Save It: A file is exported to the previously defined path. 

• Don't Save It: The export process is canceled and the window closes.
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12 Software Update 
Description: This dialog window displays available updates for the application and allows you to download and 

install updates. 

 

12.1 How to Use 
1) Go to the "Help" tab. 

2) Choose "Update". The dialog window that opens shows whether an update is available or whether the 

currently installed software is the latest version. 

3) If the software is not up to date, click on the link to perform the update.
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13 About the Software 
Description: This dialog window displays information about the application. 

 

13.1 How to Use 
1) Go to the "Help" tab. 

2) Choose "About...". Here you will find the version number of the software and the licenses of all open source 

third-party providers.
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14 FAQ 

14.1 ST®Drive fails to establish a connection to the ST500 frequency 
inverter, what can I do? 
1) Connect the supplied adapter to the RS485 terminals. (Connect the blue wire to 485+ (plus) and the brown 

wire to 485- (minus)). 

2) Plug the other end into a free USB port on your computer. 

3) The drivers are installed automatically. 

4) Look in the Device Manager for the number of the virtual COM port. 

5) If you have several virtual COM ports in your system and do not know which one is the new one, unplug 

the connector again, note which COM ports are still available and plug the connector back in. The newly 

added port is the COM port for the ST®Drive. 

6) Open the ST®Drive software 

7) Click on the green button at the bottom left. 

8) Add the device manually. 

9) The device address can be freely selected (this is for larger bus systems) 

10) Select the appropriate COM port. 

11) Set the baud rate to 9600. 

12) The name of the device can also be freely selected 

13) Select "Add Device". 

14) The device should now be recognized and appear in the list on the left. 
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